
Rev 2018.3     (1) 

 

   
 

SCHEDULE PROCEDURES 
For Creating, Formatting, Updating & Maintaining 

Template Rev 2020 

 

SCHEDULE AGGRESSION BEST PRACTICES: 

Schedule Mantra – S.A.M. 

Set Expectations, Align Resources, Measure Performance 

 

1. The project schedule duration which Estimating used to bid projects with is the 

worst-case scenario for Final Completion.  Goal is to develop a more aggressive 

project schedule for subcontractors to create float between the owner schedule, 

and subcontractor schedule. The owner schedule is a summary schedule and 

typically does not account for the amount of detail that gets added as the project 

evolves by the project Superintendent. The added float in your schedule helps 

absorb the added detail. All owner related critical path impacts should be 

documented with the owner at the time of impact (Within 48 of occurrence), and 

added to the overall completion of the project to maintain the float between 

subcontractor and owner completion. The project teams need to manage the 

project to protect the float, and keep it in tact. Negotiations with subs to recover 

impacts should occur within (2) days of the delay, a written notice should be 

provided to the responsible sub by the Superintendent and a recovery schedule 

needs to be developed to get the project back on track.  

2. Immediately upon award of project to Kier Construction, a proposed 

subcontractor list is presented by Estimating to Operations (project team and 

director).  Operations approves this list or requests reasonable changes. It is 

recommended that operations when assigned be engaged as early as possible, 

including on bid day to provide input on bids and prevent non-qualified 

subcontractors from being carried on the project.  

3. The subcontractor interview process immediately follows approval of proposed 

subcontractor list and interviews are scheduled by Estimating based on 

sequential priority, starting with the excavator, concrete, MEP, framing, etc. 

giving consideration for long lead items and submittal/shop drawing time frames. 

The project team consisting of the PM and Superintendent need to have a 

preliminary plan of intentions to build the project, showing sequencing, staging, 

site-specific logistics, and if there are any options for phasing. They should bring 

the plan to the interviews. A preliminary construction schedule should be built 

prior to the interview process, and the team should be prepared to negotiates 

aggressive durations and productivity rates for each work scope/phase.  
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Durations and productivity rates are established using terms which the 

subcontractor commonly uses to measure production. Like SF, units per day, 

etc. It is important for the team to ensure that the preceding trades are held 

accountable to their durations, so that the agreed upon durations can be met by 

the respective subs. See attached standard for Multi-Unit Group. Be prepared to 

negotiate performance, and make sure if accommodations are made, and they 

are input into the schedule to ensure they fit within the subcontractor schedule 

before making any concessions. This process can extend longer then just the 

interview process, but is intended to ensure that both Kier and the sub have 

come to terms with performance expectations. You will also find in this process, 

that is likely you need to entertain multiple companies per trade. When possible, 

the PM should put together a schedule, and include it as part of the bid 

documents. This will help ensure subs are aware of performance expectations 

at the time they bid a project.  

4. Following the necessary subcontractor interviews, a Notice of Intent is sent out 

by Estimating to the subcontractor that the project team selects. 

5. The negotiated durations and productivity rates are included in the 

subcontractor’s Exhibit C. Delays in meeting the durations and/or productivity 

rates are tied to any Liquidated Damages applicable on the project and include 

extended GC’s Kier Construction incurs because of the delays. A fixed daily 

impact $$ (Example $2,500 a day) amount should be identified at project 

commencement, and attached to all subcontractor delay notices. A delay cause 

by the respective subcontractor, is their failure to maintain the specific daily or 

weekly production expectation. The intent of daily and/or weekly tracking is to 

identify performance issues quickly in the construction schedule, and address 

them to minimize long term impacts.  

Example A: 
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Example B: 

 

 

Example C:   

 

1. The superintendent then takes all the negotiated durations and uses them to 

create a Master Subcontractor Schedule in MS Project.  Schedule may be 

resource loaded with the subcontractor’s company name to facilitate filtering 

one subcontractor’s activities throughout the project.  Once complete, set a 

project baseline to measure if the project is ahead of schedule or behind 

schedule.  The baseline should be ran weekly to accurately track impacts. 

Owner delays should be recovered via change order as soon as they occur. 

Subcontractor delays, should be notified and a recovery schedule should be put 

together immediately to get the project back on track.   

2. Preconstruction meetings are held with the contracted subcontractors including 

their project manager and field supervisor/foreman. (The representative 

identified by the respective company to attend those meetings, needs to have 

authority to make manpower commitments. It is the responsibility of the PM and 

Superintendent to enforce those expectations) Durations and productivity rates 

are reviewed and re-emphasized heavily at this meeting. Other normal topics 

are covered as well. Also, distribute a resource filtered schedule (filter by 
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company name) and review it with each subcontractor to confirm complete 

understanding of start dates and durations. Start dates are always subject to 

change, but the project team needs to keep the subs impacted, informed of 

those changes.  

3. The superintendent measures subcontractor performance by updating the 

Master Subcontractor Schedule weekly at a minimum. Delays are documented 

as an inserted activity immediately following the impact and linked to the activity 

that failed to finish on time, with the appropriate delay time adjusted accurately. 

Successors activity are linked to the end of the delay activity. Subcontractor 

should be notified immediately of the impacts via letter, and a recovery plan 

needs to be made. 

4. The superintendent proactively uses the Master Subcontractor Schedule to 

produce a 3-week schedule and review this in weekly subcontractor 

coordination meetings to further re-enforce the importance of each trade 

meeting their deadlines. This meeting should be used to review the next week 

activities, discuss specific obstacles each trade may encounter, and coordinate 

among each other to ensure activities can be met. This helps create a team 

culture that fosters the willingness of subcontractors to do their part, to make a 

project successful by holding to their required durations.  The Superintendent 

needs to ensure that representatives at the meeting can make decisions on 

manpower. If a sub has slipped, commitments need to be made on what 

intentions are to make up time. The Superintendent should set expectations 

early, on who represents the respective subcontractors.  

5. Subcontractor loyalty is built when the project is consistently ready for subs 

when they are scheduled to be on site.  The Superintendent should require all 

subs to begin visiting the site, and attending coordination meetings 3 weeks 

before an activity is scheduled to start. This will help get subs visiting the site, 

providing input on what’s needed, and encouraging them to walk the areas prior 

to mobilization to ensure we do our part in getting ready for them. Delays cause 

distrust in Kier’s ability to manage the project.  If delays occur, proactive/early 

communication may help rebuild trust. If you want subs to keep their 

commitments you need to keep yours! It’s critical to ensure there is enough 

work on site for a subcontractor to stay productive, and remain on site as long 

as possible. Requiring a sub mobilize frequently, to just demobilize shortly after 

will also compromise and discredit schedule as well.  

6. The PM creates and updates a separate Owner schedule throughout the 

project.  This schedule attempts to not show subcontractor delays, but does 

document owner delays. The purpose for this is because Kier Construction has 

been contracted to manage subcontractor delays. Do not commit to make up 

owner delays, document them, and get them added to the overall schedule at 

the time they occur. An explanation of the critical path impact, along with a 

schedule justifying the duration and link to the critical path NEEDS to be 

included with all claims for time. A claim for time should be included with a 
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change order, RFP, and always be formalized and adjust the overall completion 

of the project. Communicate openly at OAC meetings or via emails about delays 

and their costs as they happen. Include a tracking log in the meeting minutes for 

owner delays. Show why you incurred the impact, and how you arrived at the 

number of days you were impacted. The more information you provided early, 

and can show the claim, the more likely the owner will be willing to entertain it. 

Also, provide deadlines to owner that mark when delays will start to be incurred 

for approaching decisions.  Owner delays (both days and GC costs) are 

requested at minimum on a monthly basis, similar to weather delay days. 

Example #1: 

 

 

Example #2: 
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SCHEDULE TEMPLATE FORMAT: 

Current schedule template saved location: 

 H:\01 Project Management\01 Project Management\Scheduling 

Pages 3 – 7 are already included in the current schedule template.   

A. Header & Footer Setup 

1. Go to File>Print>Page Setup 

 

1. Select Header 

a. Left Section 

i. The Kier Logo has been input here 

b. Center Section 
i. Enter the Project Name using the font style/size shown below 

1. Calibri, size 22, red font, bolded 

c. Right Section 

i. Input the Owner Logo 
2. Footer  

a. Left Section 

i. Enter the Project Name on the first line 

ii. Data Date 
1. This date needs to be updated manually based off the date of last 

update 

iii. Run Date  

1. This will automatically update at time of printing 
b. Center Section 

i. Update Version – the description below this title needs to be updated 

throughout the project to one of the following or similar as needed: 

1. Proposal Schedule 
2. Initial Schedule 

3. Monthly Updates 

c. Right Section 

i. Page # 
3. Legend – this section is by default already deselected in the Page Setup dialogue box 
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B. Gantt Chart View 
a. The Gantt Chart has been set up and formatted for your use.  The section below 

describes how it has been formatted, so that if you need to add additional 
sections, you can format them to match.  

 

1. Work Breakdown Structure (WBS) 
a. Column Header Row  

i. This will print as white fill with black lettering automatically 

b. WBS Headers  

i. Fill Color Scheme 

1. Tier 1: Blue, Lighter 60% 
a. Includes headers such as Project Milestones, Project 

Delays, Submittals, Procurement, etc. 

2. Tier 2: Gold, Lighter 60% 

a. Includes headers indented under Tier 1 headers.  Such as 
Construction Administration, OFOI, OFCI, Civil & Site, etc. 

3. Tier 3: Grey, Lighter 80% 

a. Includes headers indented under Tier 2 headers.  Such as 

Structure, Roof, Exteriors, Interiors, etc. 
ii. Font 

1. Calibri, size 12, black font, bolded 

c. Regular Tasks 

i. Fill Color Scheme: No Fill Color 

ii. Font: Calibri, size 11, black font 
d. Critical Tasks 

i. Fill Color Scheme: No fill color 

ii. Font: Calibri, size 11, RED font 

iii. Includes  
1. NTP Contract Start Date 

2. Contract Substantial Completion Date 

3. Projected Substantial Completion Date 

4. Final Completion 
2. Activity Bars 

a. Baseline applied at Initial Schedule version 

b. Critical Path Activities 

i. Red  
c. Activity Name  

i. To the left of the activity bar 



Rev 2018.3     (8) 

 

3. Tasks  

a. Remember: This template is meant to be starting point only, that will allow all Kier 

schedules to convey similar critical information in a standard format.   
b. CONTRACT ADMINISTRATION 

i. These durations must be set at zero (0) day duration in order to create 

the task as a milestone activity 

ii. Minimum Milestones – only remove if not applicable to the project 
1. Contract Award 

2. NTP Start Date 

3. Slab on Grade Complete 

4. Structure Complete 
5. Roof Dry-In Complete 

6. Exterior Openings Complete 

7. Exterior Finishes Complete 

8. Site Paving Complete 
9. Certificate of Occupancy Received 

10. Contract Substantial Completion Date 

11. Final Completion 

12. Revised Final Completion with accepted delays (identify days) 
13. State of Utah NOC Filed 

c. PROJECT DELAYS 

i. Utilize this section to communicate and document owner project delays 

that may extend the contract time established in the contract agreement.  
Being proactive and transparent about all delays will help establish 

responsibility for each delay.  Documented delays allow change order 

time extension requests to be approved in a much easier manner. 

ii. Types of possible delays: 
1. City Delays 

2. Weather Delays 

3. Change Order Delays 

4. Procurement Delays 
5. Design Team Delays 

6. Unforeseen Delays 

7. Etc.   

iii. Subcontractor Delays 
1. Do not utilize this Project Delay section for subcontractor delays.  

The superintendent will utilize the Master Subcontractor Schedule 

to document delays in-line when they occur on the project.  A 

delay activity is to be added following the original activity, with the 
original activity linked to the delay activity as a predecessor and 

the original successor activity linked to the delay activity as a 

successor.   

d. SUBMITTALS, SHOP DRAWINGS & SAMPLES 
i. List critical submittals only.  Not intended to be a comprehensive 

submittal log. Intent of this list is to identify long lead items, MEP, and 

Finishes. Items most commonly impacted by design team, and owner 

decisions that can impact critical path.  
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ii. Determine review and approval timeframes.   

iii. Link these activities as predecessors to the Procurement, Fabrication, 

and actual activities. 
e. PROCUREMENT & FABRICATION – LONG LEAD ITEMS 

i. List critical long lead items.  Not intended to be a comprehensive 

procurement log. Items most commonly impacted by design team, and 

owner decisions that can impact critical path.  
ii. Determine procurement and/or fabrication timeframes 

iii. Link these activities as predecessors to the installation tasks. 

f. OWNER ITEMS 

i. Owner Furnished Owner Installed 
1. Installation dates for all OFOI items to allow the owner to 

coordinate the supply and install of these items. 

ii. Owner Furnished Contactor Installed 

1. Installation dates for all OFCI items to allow the owner to 
coordinate the supply of these items. 

g. CONSTRUCTION 

i. Expand these as much as necessary to capture all project task.   

ii. CIVIL & SITE 
1. SWPPP 

2. Mass Grading 

3. Footing Excavation 

4. Utilities 
5. Curb & Gutter 

6. Hardscape 

7. Paving 

8. Landscape 
9. Kier Deficiency List 

10. Owner & Architect Punch List 

11. Final Clean 

iii. BUILDING/AREA 
1. STRUCTURE 

a. Footings 

b. Foundations 

c. Slab 
d. Framing/Steel 

2. ROOF 

a. Single-ply, Metal, etc. 

b. Mechanical 
c. Electrical 

d. Kier Deficiency List 

e. Owner & Architect Punch List 

f. Final Clean 
3. EXTERIORS 

a. Air & Vapor Barriers 

b. Glazing 

c. Finishes 
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d. Kier Deficiency List 

e. Owner & Architect Punch List 

f. Final Clean 
4. INTERIORS 

a. Rough-Ins 

b. Finishes 

c. Kier Deficiency List 
d. Owner & Architect Punch List 
e. Final Clean 
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GENERAL SCHEDULE TIPS & TRICKS 

1) Utilize the indent buttons  located in the task ribbon, to nest (indent) tasks in or out in your 

Work Breakdown Structure.  This is what creates the hierarchy of tasks and provides the WBS 

numbering shown here:  

 

2) The WBS numbering should be as sequential as possible.  The WBS can always be renumbered by 

utilizing this button on the Project tab     and then selecting Renumber.   

 

3) Once all tasks are entered, given durations, and linked with predecessors and successors, set a project 

baseline by utilizing this button on the Project tab: 

 

Then update your schedule regularly and utilize it to reduce schedule slippage on your project.   
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SCHEDULE MAINTENANCE 

ESTABLISH A PROJECT BASELINE 

1. This is a CRITICAL step and should be done as part of your initial schedule set up.  You need to establish the 

baseline that all your task dates will be measured from.  This helps you determine if your project is ahead of 

or behind schedule. 

2. To set up a Project Baseline go to the Project Tab then Set Baseline.  

 

3. Here you can set baselines for the Entire Project or Selected Tasks. 

4. We will set up a Baseline for the Entire Project 

1. Toggle “Set Baseline” and toggle “Entire Project” then click ok.  

 

5. Add a “Finish Variance” column to your schedule. This will help you to easily track the variances in the 

schedule.  This column has been added to the 2018.3 template version.   
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CREATE 3-WEEK LOOK-AHEAD SCHEDULES 

IMPORTANT: Steps 1, 2, 3 (pages 10 – 16) have already been incorporated into the template version 

2018.3.  Any version prior to this, does not have these steps incorporated into it, thus they will need to be 

completed.  Or you can just get the newest version and not worry about it! 

 

1. You need to set up a Custom Field Flag to calculate the Three Week Look Ahead Schedule.  

 

A. Select the Project tab, Properties ribbon group, and Custom fields, Figure 2. 

Figure 2 

 

B. In the custom fields dialog, Figure 3, select the type Flag from the drop-down menu. Rename 

Flag1 “3 Week Look Ahead”. 
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Figure 3 

 

C. Toggle Formula in the custom attributes, Figure 4. 

Figure 4 

D. Below are the step-by-step instructions on how to set up the formula.  As a shortcut, you can 

just type in the formula below:   

a. IIf(([Start]<([Status Date]+21) And ([% Work Complete]<100)),"Yes","No") 
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E. Click the formula button. Select the Function General and select: IIf(expression, truepart, 

falsepart), Figure 5. 

Figure 5 

F. Set the truepart to “Yes” and the falsepart to “No”, Figure 6. (Change your formula so it 

reads as shown in Figure 6). 

Figure 6 

G. In Figure 7 we enter the Start Date field into the formula. 
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Figure 7 

 

H. Next, we enter “Status Date” into the formula, Figure 8. 

Figure 8 

I. Here we want to capture all tasks that have a start date less than the status date plus 21-

days, Figure 9. 
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Figure 9 

J. Also, in Figure 9, we insert the % Work Complete field into the formula. Only tasks that have 

a % complete less than 100, i.e. incomplete tasks, are captured. Completed tasks are filtered 

out. The final formula is in Figure 10, which will capture all tasks starting within 21-days of 

the status date and all non-complete, i.e. in-progress tasks within this time period. 

Figure 10 

  

2. Now that the formula is complete, we continue by creating a Flag Filter.  

A. Select ‘New Filter’ in the View tab, Data ribbon, and Filter drop down menu,  
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Figure 1 

B. Name the filter ‘3 Week Look Ahead’, Figure 12. 

Figure 12 

 

C. Enter “3 Week Look Ahead” under the Field Name column 

D. Select “equals” under the Test column drop down menu 

E. Select “Yes’ under the Values drop down menu. 

F. Click “Save”. 
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APPLYING THE 3-WEEK LOOK-AHEAD FILTER 

Return to your schedule and select the 3 Week Look Ahead filter from the Filter Drop Down Menu. 

Figure 13 

The 3 Week Look Ahead Schedule will be displayed. 

Figure 14 

To return to your full schedule, select “No Filter” from the Filter drop down menu.  
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REGULAR PROGRESS UPDATING OF SCHEDULE 

The schedule is most useful when it is frequently updated. 

The steps necessary for keeping a project updated in MS Project are: 

1. Set Project Status Date 

2. Capture Updates 

3. Update Project Progress 

4. Reschedule Incomplete Work 

5. Make Necessary Revisions 

Notice that this is a constant cycle that will repeated over and over throughout the project (weekly at a 

minimum). 
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1. Set the Status Date.  Understand that the Status Date is the date that you have the most up to 

date information for (the information that the schedule is valid to).  

 

2. If your schedule template does not already have columns for Actual Start, Actual Finish, % 

Complete, Actual Duration, Remaining Duration, Actual Work, Remaining Work, add those to 

your schedule now.  These columns have already been added to the 2018.3 template version. 

3. METHOD 1: Update tasks by percent complete.   

a. Highlight a particular task then go to the Task bar on the Ribbon, then select a 

Percentage Complete (0%, 25%, etc.) to assign to that task. This is the simplest method, 

but doesn’t give you very much information about what happened. 

b. To show as much information as possible, input the actual start and actual finish date 

for the task. 

  

4. METHOD 2: Actual Work and Remaining Work  

a. Update the actual work completed (hours) for the task. 
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b. Update the remaining work to be completed (hours) for the task.  The remaining work 

to be completed may be MORE than was originally anticipated for this task and 

therefore delays the finish date for that task. 

 

5. Rescheduling Incomplete Work 

a. First, find where the problem lies – what task has started the delay(s). 

b. Click on that task.  Click on the Project tab in the Ribbon, then select Update Project in 

the Ribbon.  

 

 

c. Toggle on “Reschedule uncompleted work to start after” and enter the Status Date. Toggle on 

“Selected tasks”.  (You can also complete this for the Entire project all at once by toggling on 

“Entire Project”, however it may be more beneficial to do this on a task-by-task basis as you can 

more carefully track each task). 
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d. As you do this, check to see what other tasks this may have affected and repeat this 

process as needed to update tasks.   
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INTERFACING MS PROJECT SCHEDULE WITH PROCORE 

Before you can upload a schedule using Procore Drive, you need to configure the Schedule tool in 

Procore for the file type you're going to integrate with. (Note: You need 'Admin' level permissions to 

configure the Schedule tool.) 

1. Navigate to the project's Schedule tool. 

2. Click Configure schedule settings. 

3. Click the Schedule Settings page.  

4. Under the Upload Project Schedule Files section, select 'File upload via Procore Drive.' 

5. At the bottom of the page, click Update. 

 

Steps 

1. Launch Procore Drive (i.e., Start > Programs > Procore Drive). 

2. Select your company and project from the drop-down menus. 

3. Select the Schedule tool. 

4. Click Upload MPP. 

(Note: If the project scheduling preference is currently configured for a "Primavera Integration," 

click the Change to Microsoft Project Integration button.) 

5. Browse your local file system and select the appropriate Microsoft Project file (*.mpp). 

6. Click Open. 

7. Log in to Procore, and verify that you can see your schedule and all of its data under your 

project’s Schedule tool. Use the various “View by” options to change how the information is 

displayed. 

 

UPDATING A SCHEDULE IN PROCORE 

Steps 

1. Launch Procore Drive. (e.g., Start > Programs > Procore Drive). 

2. Select your company name and project from the drop-down menus. 

3. Select the Schedule tool. 

4. Click Launch MPP. (Note: The project schedule file will be opened directly in Microsoft Project, 

not in Procore Drive.) 

5. Make any necessary updates to the Microsoft Project schedule. 

6. Click Save.  

Note: It is important that you click Save, and not Save As. If you click Save As to save your 

progress to a new file, this file will not be sent to Procore, as it is not the linked file. 

7. Enter a brief description of the changes. All changes will be saved back to Procore in real time 

and will be available to the rest of the project team. 

Note: If you would like Procore to automatically send a notification to members of your team 

when schedule updates are uploaded to the Schedule tool, Configure Schedule Notification 

Emails and mark the "Upon Schedule Changes" option.  
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VIEW A PROJECT SCHEDULE 

Steps to View By Week 

1. Navigate to the project's Schedule tool. 

By default, the schedule displays in Week view. You will see all completed tasks, tasks in 

progress or critical paths for that week. 

 

 

 

Steps to View By Day 

1. Navigate to the project's Schedule tool. 

2. Click Day in the 'View By' box in the right sidebar. 

You will see a list of all tasks scheduled for that day, as well as the resource, the start and finish 

date and the percentage complete for each task.  

 

 

  

Steps to View By Month 

1. Navigate to the project's Schedule tool. 

2. Click Month in the View By box in the right sidebar. 

You will see the month's calendar with all completed tasks, tasks in progress and critical paths 

for that month. 
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Steps to View a Gantt Chart 

1. Navigate to the project's Schedule tool. 

2. Click Gantt Chart in the View By box in the right sidebar. 

You will see a Gantt Chart with horizontal lines that demonstrate the amount of work done 

relative to the amount of time given to complete that task.  

 

 

View All 

1. Navigate to the project's {{schedule_uc_word}} tool. 
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2. Click All in the View By box in the right sidebar. 

You will see a list of all scheduled items, as well as their resource, start and finish date and 

percentage complete.  

 

CONFIGURE SCHEDULE NOTIFICATION EMAILS 

Steps 

1. Navigate to the project's Directory tool.  

This reveals the Project Directory. 

2. Click the Users tab. 

This reveals a list of people on the project.  

3. Locate the user's name. Then click Edit. 

4. Scroll to Schedule Notifications. 

5. Place a checkmark in the box(es) that correspond to the desired notification(s): 

o All Project Tasks. Mark this checkbox to notify the user about all project tasks.  

o Resource Tasks Assigned To. Mark this checkbox to notify the user about any resource 

tasks assignments.  

o Upon Schedule Changes. Mark this checkbox to notify the user about changes to the 

project schedule.  

o Upon Schedule Changes Requests. Mark this checkbox to notify the user when a change 

request is made to the project schedule.  

6. Click Save. 

Note: The user will now receive schedule notification emails when team members make these 

changes in the future. 

 

SCHEDULE CHANGE REQUEST SUBMITTED BY SUBCONTRACTOR 

Steps 

1. Navigate to the project's Schedule tool. 

2. Locate the task for which you want to request a schedule change. See "Search and Filter for the 

Schedule Task" in the See Also section below. 

3. Select the schedule task from the calendar. 

4. On the View page, fill out the information under Request a Schedule Change for the Task. 
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o Start Date: If you would like to request a change to the start date of the task, enter a 

new start date. 

o Finish Date: If you would like to request a change to the finish date of the task, enter a 

new finish date. 

o Percent Complete: If you would like to request a change to the percent complete, 

click Change, enter in the new percent, and click OK. 

o Other Change: If you would like to request a change to something else besides the 

start/finish date and the percent complete, enter in the details of the change you wish 

to make. 

o Reason For Schedule Change Request: Enter in the reason for the change you are 

requesting so the Schedule tool Admin user can better understand the change.  

Note: Any users who are configured to receive update emails when change requests are 

made will be notified of the schedule change request. See "Configure Schedule 

Notification Emails Sent to a User" in the See Also section below. 

5. Click Request. 

Note: When your change is approved, it will appear as 'Approved in the Schedule Change 

Request History' section. However, changes to the actual schedule must be performed in your 

scheduling software. 

 

REVIEW SCHEDULE CHANGE REQUESTS 

When a schedule change is requested of a task, you will receive an email from Procore notifying you of 

this change. From that email, view the details, make any changes to the schedule, and click View 

Online to review the change request. Skip to step 5 if you're navigating to the change request from the 

email. 

Steps 

1. If you are integrating a Microsoft Project or Primavera schedule with Procore, go into that 

software and make the changes requested.  

2. Navigate to the project's Schedule tool. 

3. On the list page, click Review Pending Schedule Change Requests under the Schedule 

Integration section. 



Rev 2018.3     (29) 

 

 

 
  

4. Next to the schedule change request, mark the request as Task Updated or Request Rejected in 

accordance with the actions you took prior to reviewing this change. 

5. Add any reasons or notes clarifying the change or rejection. 

 

 

6. Click Save.  

Note: When the change is approved, it will appear as "Approved" in the Schedule Change 

Request History section of the scheduled task. 

Important! When you approve a schedule change request, it will not update the schedule with 

these changes. You will need to change the schedule in the integrated schedule software and be 

sure to upload your new schedule to Procore before it can be visible to the team. 

 

SEND RECURRING 3-WEEK LOOK-AHEAD SCHEDULES 

Steps 

1. Navigate to the project's Schedule tool. 

2. Click Configure Schedule Settings. 

3. Click Email Settings. 

4. To send Weekly Project Schedule, see the following: 

5. Mark the Enable Weekly checkbox to send weekly emails to specified users showing all 

upcoming tasks on the project schedule.  

6. Next to Settings, set when the emails will be sent, and how many weeks will show in the email. 

7. When you're done setting this information, navigate to the Permissions Table page. 

8. Select which users will receive emails by checking the box in the Weekly Project Email column.  
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9. If you would like to send a weekly project schedule immediately, follow the steps below. 

10. Once you set this, navigate back to the Email Settings page. 

11. Click Send Project Schedule Now. 

12. To send Weekly Resource Schedule, see the following: 

13. Mark the checkbox next to Enable Weekly to send weekly emails to specified users showing all 

upcoming tasks on the project schedule.  

14. Next to Settings, set when the emails will be sent, and how many weeks will show in the email. 

15. When you're done setting this information, navigate to the Permissions Table page. 

16. Select which users will receive emails by checking the box in the Weekly Resource Email 

column.  

17. If you would like to send a weekly resource Schedule immediately, follow the steps below. 

18. Navigate back to the Email Settings page. 

19. Click Send Resource Schedule Now. 

 

 

 

 


